Read Me

Pro Tools and Pro Tools | HD Software 12.7

on Mac OS X 10.9.x, 10.10.x, 10.11.x, and 10.12.x
This Read Me documents important compatibility information and known issues for Pro Tools® and Pro Tools | HD Software 12.7
on Mac OS X 10.9.x (“Mavericks”), Mac OS X 10.10.x (“Yosemite”), Mac OS X 10.11.x (“El Capitan”), and Mac OS X 10.12.x
(“Sierra”).
For detailed compatibility information, including supported operating systems, visit the Pro Tools compatibility pages online.

Avid Artist Community
Avid Artist Community is the new marketplace where you can share and promote your creative work and skills to a large community
of audio, film, TV, broadcast, and other media professionals.
Visit www.avid.com/artistcommunity to find out all the details of how to sign up and start interacting with other Community members.
Once you are a registered user, visit ac.avid.com to log in.

Compatibility
Avid can only assure compatibility and provide support for qualified hardware and software configurations.
For the latest compatibility information—including qualified computers, operating systems, and third-party products—visit the Avid
website (www.avid.com/compatibility).

Updated EuControl Appset for Artist Control, Pro Tools | Control with Pro Tools 12.5 or
Later (PT-213555)
An updated Appset for Artist Control and Pro Tools | Control is provided with Pro Tools 12.5 or later. This includes an improved and
more intuitive Soft Key layout as well as additional assignments for newer Pro Tools EUCON commands. Visit EuControl Appsets to
download the latest EuControl Appsets.

iLok USB Smart Key and Pro Tools Authorization
An iLok must be connected at all times while running Pro Tools

Pro Tools requires that an iLok (2nd generation or later) with the appropriate authorizations be connected to the computer at all times.
Do not remove the iLok while running Pro Tools. If the iLok is removed while Pro Tools is running, one of the following will occur:
Pro Tools displays a dialog giving you the following choices:
• Reinsert the iLok and click Save. Pro Tools saves the session and then quits.
• Click Quit. Pro Tools closes the session without saving and then quits.
– or –
Pro Tools displays a dialog giving you the following choices:
• Reinsert the iLok and click OK to continue working in Pro Tools.
• Click Cancel. Pro Tools closes the session without saving and then quits.
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Avid Application Manager
Use the Avid Application Manager for notifications about Pro Tools software and plug-in updates

When you install Pro Tools 12.x, the Avid Application Manager is also installed. The Avid Application Manager is used to manage your
software and entitlements related to your Avid Master Account. The Avid Application Manager helps you maintain the most current
Pro Tools software and audio plug-in updates that you are entitled to when new versions become available. For more information about
the Avid Application Manager, see the Avid Application Manager Guide (available online through the Avid Knowledgebase).

General Compatibility
Pro Tools 12 does not support video capture (PTSW-181456)

Pro Tools 12 does not have the ability to record video to the timeline. Use another application or a lower version of Pro Tools with a supported video peripheral to capture video and then import it into Pro Tools 12 (and higher) sessions.
Avid Video Engine (AVE) is not supported with drives that are case-sensitive formatted (UME-1223)

The Avid Video Engine (AVE) will not load on Mac OS X if the OS drive/volume is formatted as Mac OS Extended (Case-sensitive,
Journaled). In order for AVE to load, the OS drive/volume must be formatted as Mac OS Extended (Journaled).
Pro Tools 12 does not allow import of WMA files (PTSW-181506)

If you attempt to import a WMA file into a Pro Tools 12 session, Pro Tools cannot convert the file and posts a “file is unreadable”
message. Co-install Pro Tools 10.3.10 (or higher) on the same system, import the WMA file, and convert it to a format supported by
Pro Tools 12.
Some contextual menus are not accessible using a key modifier and Left-click. (PT-218014)

Not all contextual menus can be viewed using a key modifier and Left-click (primary click). For example, Control-clicking a plug-in parameter cannot access its contextual menu because Control is an isolating modifier for plug-ins. Be sure to enable Secondary Click in
the Mouse System Preferences (Apple menu > System Preferences > Mouse), and the use the secondary button on your two-button
mouse (typically Right-click) to access all contextual menus in Pro Tools.
After creating a new user account on Mac OS X, you can initially only save a Pro Tools session in a non-local folder called
“Documents” (PT-204548)

To avoid this issue, create a folder named “Documents,” save a session there, then save the session and all other subsequent sessions
wherever you wish.
QuickTime Player is not currently compatible with Avid Audio Interfaces on Mac OS X 10.8 and 10.9 (PTSW-163965)

QuickTime Player does not currently support Avid audio devices as output devices with Mac OS X 10.8. Audio will not pass through
and playback will not start. Please use an alternate audio interface for QuickTime Player, or use another software solution for playing
back QuickTime files with Avid audio devices as a workaround for this issue.
Warning displayed when opening a session or project created in Pro Tools 12.6 in a lower version of Pro Tools. (PT-220349)

Any session or project created with Pro Tools 12.6 presents a warning when opened in a lower version of Pro Tools (such as Pro Tools
12.5). When the session is opened following this warning, any clip effects data will be dropped from that session or project. If you save
the session or project in the lower version of Pro Tools, the Save As dialog opens instead so that you do not overwrite the original 12.6
session or project.
Installing the Avid HD Driver 12.6.1 or higher with any lower version of Pro Tools, Pro Tools HD, or Pro Tools First results in an
AAE –1133 error on launch of the lower version of Pro Tools. (PT-223011)

Avid recommends that you do not install and use versions of Pro Tools, Pro Tools HD, or Pro Tools First lower than 12.6.1 with the Avid
HD Driver 12.6.1 or higher. If you must do so, please uninstall the Avid HD Driver 12.6.1 (or higher) and install a lower version of the
Avid HD Driver. Alternatively, when launching any version of Pro Tools lowest than 12.6.1 on an HDX or HD Native system with the
Avid HD Driver 12.6.1 or higher installed, press and hold the N key on launch and select a different Playback Engine than the Avid HD
Driver (HDX or HD Native).
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Pro Tools 12 sessions that use more than 4 gigabytes of RAM will cause Pro Tools 10 or lower to quit unexpectedly
(PTSW-181963)

If you attempt to open a Pro Tools 12 session that uses more than 4 gigabytes of RAM in Pro Tools 10 or lower, Pro Tools will quit unexpectedly. To open such sessions in Pro Tools 10 or lower, first reduce the amount of session RAM usage to less than 4 gigabytes in
Pro Tools 12 by removing virtual instruments that take up system memory.
Nudge Selected Clip Gain shortcuts may conflict with the default Mac OS X shortcuts for Mission Control (PT-210366)

Performing the Nudge Selected Clip Gain Up/Down shortcuts may trigger Mission Control functions in some versions of Mac OS X.
To avoid this conflict, click the Keyboard icon in System Preferences, select the Shortcuts tab and then Mission Control from the sidebar. Disable or reassign the Mission Control and Application Windows shortcuts.
Enable Spotlight for best performance when relinking files and indexing in the Workspace (PTSW-183818)

For best performance with relinking and Workspace indexing, enable Spotlight. While enabling Spotlight is not required, it will improve
performance in this area with Pro Tools.
When Spotlight is enabled, long record passes (over 50 minutes) may stop recordings after 50+ minutes. Consider disabling Spotlight
for long recording sessions and then re-enable it when you are done recording.
Mac OS VoiceOver does not work with Revision History or Soundbase. (PT-223942)

The Versions list in the Revision History window and Tags in Soundbase in Workspace browsers do not support Mac OS VoiceOver
(System Preferences > Accessibility > VoiceOver) at this time.
OMF files that contain video are not compatible with Pro Tools 12 (PTSW-184397)

OMF sequences that contain video cannot be imported into Pro Tools 12. OMF sequences that contain embedded or referenced audio
files can be imported into Pro Tools 12. To import a sequence that contains video media, use a linked AAF sequence.
Pro Tools session file formats version 4.x and lower are not supported in Pro Tools 11 and higher (PTSW-181049)

Pro Tools session files from Pro Tools versions 4.x and lower are not recognized in Pro Tools 11 and higher. In the Pro Tools Workspace, these files are listed as “unknown,” and cannot be opened. Co-install Pro Tools 10.3.10 (or higher) on the same system and open
the session files in Pro Tools 10. Save the session in the current Pro Tools session format, then open the session in Pro Tools 12.

Pro Tools | HDX Systems
Some Mac Pro computers with certain video cards may not have power connections available for Pro Tools | HDX cards (PTSW156545)

Some video cards require power from the motherboard, which is also a requirement for HDX cards. If you have a video card that requires both power connections on the motherboard, a power connection for your HDX cards will not be available. To avoid this problem, use a video card that does not require more than one power connection to the motherboard.

Pro Tools | HD Native PCIe Systems
With Mac OS 10.6.8 or higher, it may not be possible to update the firmware on an HD Native PCIe card (PTSW-146374)

When launching Pro Tools HD with an HD Native card on Mac OS 10.6.8 or higher, a –1164 error may occur. This error indicates that
the firmware for the HD Native card cannot be updated from version 1.0 to version 1.02 or 1.03. If this error occurs, you can only update
the firmware using Mac OS X 10.6.7 or lower. The firmware update can also fail when using a Thunderbolt MacBook Pro. To avoid this
error, use a Mac without Thunderbolt and use the Avid NativeCardFlasher utility to update the HD Native firmware,
For more information on updating Native card firmware, refer to the following Avid Knowledge Base articles:
http://avid.force.com/pkb/articles/en_US/troubleshooting/en419331
http://avid.force.com/pkb/articles/en_US/troubleshooting/en429831
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Eleven Rack
Eleven® Rack Guitar Window not available in Pro Tools 12 (PTSW-184398)

Pro Tools 12 does not provide the Guitar Window for Eleven Rack that is available in Pro Tools 10 and lower. Avid has made available
a 64-bit standalone version of the Eleven Rack Control Window found in Pro Tools 10 and earlier. Please see the following page for
more information about the 64-bit standalone Eleven Rack Editor: http://apps.avid.com/eleven-rack/

VENUE
Restarting a VENUE console, including the changing of system configurations, leads to an audio interface timeout with a
connected HD Native system (PTSW-183745)

When connecting a HD Native system (PCIe or Thunderbolt) to a VENUE live sound system, VENUE HDx cards acting as your interface to Pro Tools timeout when restarting the VENUE console. This includes changing the VENUE system input configuration between
stage and HDx sources (Virtual Soundcheck). After timing out, Pro Tools cannot record or playback until you quit and relaunch
Pro Tools.

Known Issues
The following sections document known issues you may encounter when using Pro Tools and Pro Tools HD 12.7, along with
workarounds if they exist.

General Pro Tools Issues
Pro Tools quits unexpectedly while loading plug-ins on launch. (PT-206888)

On Pro Tools systems with several hundred plug-ins installed, Pro Tools may quit unexpectedly on launch. If this occurs, try the following:
• Move approximately 100 plug-ins (or more) from the Plug-Ins folder to the Plug-Ins (Unused) folder (/Library/Application Support/Avid/Audio/).
• Launch Pro Tools.
• Quit Pro Tools.
• Move the plug-ins back from the Plug-Ins (Unused) folder to the Plug-Ins folder.
• Launch Pro Tools.
Pro Tools does not play back immediately after importing a large and complex AAF sequence (UME-905)

Importing a complex AAF sequence that contains many video files and edits may cause Pro Tools to be in a Play/Pause state after all
files have finished linking. This may also happen when reopening the session. If you encounter this, stop the transport, wait 30 seconds,
and then attempt playback again. To avoid this problem completely, you can bounce the video and re-import, or request that the video
editor flatten the video upon export.
Offline Bounce takes much longer than expected (PT-202888)

Offline Bounce times can increase significantly in sessions that have output and input assignments cascaded across tracks (for example:
Track 1 output is assigned to Track 2 input, Track 2 output is assigned to Track 3 input, and so on).
When importing session data, automation is replaced instead of overlaid when using Adjust Session Start Time to Match
Source Start Time (PTSW-149273)

Automation can sometimes be replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time when importing session data. This issue may occur if the source session start time (of the session being imported) is earlier than the current session start time. This issue can be avoided if you instead import the session data from the session with the later start time into the session
with the earlier start time. You must also not enable the Adjust Session Start Time to Match Source Start Time option, and select Maintain Absolute when prompted.
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Auto Low Latency Monitoring is lost when opening a session created in Pro Tools 12.6 or higher in versions of Pro Tools lower
than 12.6. (PT-219356)

If a session is saved with Auto Low Latency Monitoring (“Blue Mode”) enabled in 12.6 or higher, it is disabled when that session is
opened in versions of Pro Tools lower than 12.6 (in 12.5 for example). You will have to re-enable Auto Low Latency Monitoring if desired. This issue does not occur when opening sessions in Pro Tools 12.6 and higher that were saved with Auto Low Latency Monitoring
enabled in a version of Pro Tools lower than 12.6.
Automatic Delay Compensation cannot not be applied to tracks recording from different types of sources (PTSW-157960)

Automatic Delay Compensation cannot compensate for cascaded records that use both I/O and bus inputs to recording tracks. An example of this is feeding an audio track (in record) from an audio input, and then bussing the output of the track to another audio track
also in record. The first audio track will be compensated but the second cascaded track will not be. (This is not a common workflow.)
Cannot run Reason as ReWire clients if they have not first been launched and set up as a standalone application (PTSW-133070)

Reason needs to be launched and setup as a stand-alone applications before running them as a ReWire clients with Pro Tools. Do the
following:
• Launch Reason in stand-alone mode and follow the on-screen instructions.
• Quit Reason.
• Launch Pro Tools and insert Reason as a ReWire plug-in on an audio, Auxiliary Input, or Instrument track.
Exporting interleaved BWF files from Pro Tools 10 or higher and importing into Pro Tools 9.0.x and lower may cause Pro Tools
to quit unexpectedly (PTSW-151579)

When exporting any greater-than-stereo multichannel interleaved WAV (BWF) files other than 5.1 from Pro Tools 10 or higher and
then importing them into Pro Tools 9.x or lower, Pro Tools quits unexpectedly. To avoid this problem, export audio files for import into
lower versions of Pro Tools in another file format (such as AIFF or multi-mono).
AAF files that contain AMA-linked audio cannot be imported (PTSW-182322)

Pro Tools cannot import AAF files that contain AMA-linked audio files. AMA-linked audio must be imported or transcoded in
Media Composer before the AAF is exported.
Rendering Clip Gain or Clip Effects on multi-channel audio clips in an interleaved session results in multi-mono files.
(PT-214780)

In an interleaved session, rendering Clip Gain or Clip Effects on a multichannel audio clip creates mono audio files for each channel
rather than the expected single interleaved, multichannel audio file.
Clip Groups may require multiple clicks to be added to the edit selection. (PT-223246)

With a Clip Group selected, additional Clip Groups may not immediately be included in the edit selection when Shift+clicking them
with the Grabber or Smart tool. If you encounter this issue, Shift+click on the additional Clip Group once to expand the Timeline Selection, then Shift+click again to add the Clip Group to the edit selection.
Real-Time Fade Adjustment Tool can display the fade preview outside of the Timeline under certain Window Scrolling
conditions. (PT-220418)

If the area before the start of the Timeline is visible when using Continuous Window Scrolling or if the Center Playhead option is enabled, and the area before the start of the timeline appears on-screen, then adjusting a fade using the Real-Time Fade Adjustment Tool
can cause the fade preview to appear outside of the fade boundary or Timeline. To avoid this issue, only use the Real-Time Fade Adjustment Tool in No Scrolling, After Playback, Page scrolling modes, or when the start of the Timeline is off-screen.
Recording track group output featuring 90º volume automation changes while writing VCA automation can result in unwanted
fades. (PT-222834)

If audio clips on a track within a track group feature sharp 90º volume automation changes and the track group has a VCA assigned to
it, bus recording the output of the audio track to another audio track while VCA automation is being written may result in the new recorded audio fading in and out around the 90º volume automation changes. To avoid this issue, record any VCA automation first and
then record the track group output in a separate record pass.
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Unrendered mix and match AAFs will not properly import (PTSW-181825)

If the error “A video file and its associated clips were removed because its timecode rate is incompatible with the project type” appears,
it is likely that your AAF contains unrendered mix and match video. To avoid this, render mix and match AAFs from Media Composer
before or during export.
Clip names appear incorrect after selecting Field Recorder channel matches, or expanding to new tracks. (PTSW-136012)

This can occur if the file name of a Field Recorder channel match contains a hyphen followed by a number greater than zero. Pro Tools
names new clips by incrementing the number after the hyphen. If a field recorder file is already named in this way (such as “Filename01”), then new clips created by selecting a Field Recorder channel match or by expanding a track may have names different from the
parent file. To avoid this situation, avoid using hyphens in Field Recorder file names.
Field Recorder matches appear offset after AudioSuite rendering if the session timecode rate does not match the file timecode
rate (PTSW-152147)

If a portion of a file has been rendered with an AudioSuite plug-in, an offset can occur when expanding field recorder matches in cases
where the session timecode rate does not match the timecode rate of the audio file. To avoid this issue, you can either render the whole
file with AudioSuite (rather than only a portion of the file), or use Whole File mode when rendering AudioSuite processing.
External Field Recorder matches do not show up after an initial index pass (PTSW-180659)

If external field recorder matches do not show up on a field recorder track after the initial index pass, save and reopen the session.

Layered Editing
Fades are not restored after moving clips using the Grabber tool. (PT-207491)

With Layered Editing enabled, moving a clip that partially covers a fade on another clip with the Grabber tool so that it no longer covers
the fade does not restore the fade to its original duration. You will need to manually trim the fade to its original duration
AudioSuite rendering of overlapping clips may result in Layered Editing not working as expected. (PT-223594)

With Layered Editing enabled, if overlapping clips are selected and rendered with AudioSuite set to create individual files and entire selection, Layered Editing may not behave as expected with those clips. Additionally, if a shorter clip is placed on top of a longer clip such
that the longer clip begins and ends before and after the smaller clip, then both clips are selected and then rendered with AudioSuite set
to create individual files and entire selection or clip by clip, Layered Editing may not behave as expected with those clips either. If you
encounter this issue, choose Edit > Undo to revert to the previous layered states for these clips. To avoid this issue entirely, select only
one overlapping clip to render at a time when AudioSuite is set to create individual files and Layered Editing is enabled.
The Undo command does not remove a clip copied to a playlist by virtue of the Send Overlapped Clip to New Playlist preference.
(PT-222824)

When the Send Overlapped Clip to New Playlist preference is enabled, and you move a clip completely over another, the overlapped clip
is moved to a new playlist. However, if the track is not in Playlists view, Undo restores the clip on the main playlist, but it does not remove the clip from the alternate playlist. You will have to manually remove that clip from the alternate playlist if you so desire.
Looping clips does not send fully overlapped clips to an available playlist. (PT-219668)

With both Layered Editing option (Options > Layered Editing) and the Send Fully Overlapped Clips to Available Playlist While Editing
preference enabled (Setup > Preferences > Editing), clips that are fully overlapped by a looped clip (Clip > Loop) are not sent to an available playlist. Manually move clips that will be fully overlapped by the looped clip to another playlist before looping the clip.
Fully overlapped clip not sent to new playlist if the clip is overlapped by creating a fade. (PT-220888)

When a clip is fully overlapped by the creation of a Fade In or Fade Out, the overlapped clip is not sent to a new playlist even though
the Send Fully Overlapped Clips to Available Playlist While Editing preference is enabled. To avoid this issue, create a shorter fade and
then extend it to fully overlap the clip in question. That clip is sent to a new playlist. Alternatively, manually move the clip to a new playlist.
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When moving clips in Warp view with Layered Editing enabled, partially overlapped clips may disappear unexpectedly.
(PT-220557)

When moving clips in Warp view with Layered Editing enabled (Options > Layered Editing), partially overlapped clips may disappear
unexpectedly. To avoid this issue, conduct Layered Editing in other track views (such as Waveform view).
With Layered Editing enabled, deleting overlapping clips that were created with Duplicate or Repeat can result in some
overlapped clips being unexpectedly edited as well. (PT-220491)

With Layered Editing enabled, deleting overlapping clips that were created with Duplicate or Repeat can result in some overlapped clips
being unexpectedly edited as well depending on the order in which the overlapping clips are deleted. To avoid this issue, delete any overlapping clips in order from left to right.

Projects and Collaboration
Clip effects settings are lost when sharing tracks with Pro Tools 12.5.x. (PT-220478)

Track collaboration between Pro Tools HD 12.6 and lower versions of Pro Tools will result in losing clip effects settings on shared
tracks. Earlier versions of Pro Tools drop clip effects settings from tracks that are shared from Pro Tools HD 12.6. There is no warning
when clip effects settings are lost while collaborating. To avoid this issue, render clip effects for all clips with clip effects on tracks you
want to share with any collaborator running a lower version of Pro Tools.
Additional Playlists indicator does not appear on shared tracks with collaborators' systems (PT-219746)

If you duplicate a playlist on a shared track, the Additional Playlists indicator does not light for collaborators. Subsequently making a
change to the alternate playlist, however, does notify collaborators.
Projects may not synchronize to Avid Cloud after remaining open overnight. (PT-220208)

After a Project has been open for a protracted period of time, saving to the Avid Cloud may not succeed. If you see a Project upload not
completing in the Task Manager, it is recommended that the Project be saved and closed, and that you sign-out and then back in again.
You should then be able to complete the Project upload.
After canceling a Project upload, it can take up to two minutes before any remaining uploads in the Task Manager begin.
(PT-220170)

If Project uploads are canceled and other upload tasks remain in the queue, it can take up to two minutes for these uploads to begin. If
this issues occurs, simply wait for the remaining projects to begin uploading.
Creating or receiving new projects or tracks may result in a “Permission denied (13)” dialog (PT-212334)

When creating or receiving new projects or tracks, a “Permission denied (13)” dialog may be displayed. Should this issue occur, open
the “Operation” tab in the Pro Tools Preferences window and, in the “User Media and Settings Location” pane, click the Project Media
Cache “Change” button to set a new location for the Project Cache. The new location should be a folder either outside of the default
Pro Tools folder or off of the startup disk if possible.
It is strongly recommended that you do not log in to the same project on multiple systems using the same
Avid Master Account login

When you are connected to the internet and then you open a Pro Tools Project, Pro Tools checks to see if there are any other machines
that are logged in to the same Avid Master Account and both with the same project open. If the project is detected as being open on another system it should be closed. This prevents the project bundle on the cloud from becoming corrupted by competing updates from
multiple systems using the same account. To avoid this situation, it is strongly advised that you close projects when leaving systems idle
if it is possible that you will be working on the same project from another computer with the same Avid Master Account.
Assertions and AAE errors may occur when Project Media Cache exists on multiple identical volumes (PT-213652)

Assertions and AAE errors may occur when the Project Media Cache folder exists on multiple identical volumes. To avoid this issue,
ensure that the Project Media Cache remains set to different locations on each volume, rename each volume if possible, or unmount any
identical volumes while working with projects in Pro Tools.
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Disconnecting from the internet or closing a project during project synchronization can result in failed project synchronization.
(PT-202643)

To prevent potential synchronization with projects, do not disrupt the project synchronization while it is in progress. Avoid disconnecting from the internet, turning off WiFi, shutting your laptop, or quitting Pro Tools | First during this time. To monitor the progress of
project synchronization, choose Window >Task Manager.
Change the default Project Media Cache location so that it is not on your system drive (PT-212755)

Projects in Pro Tools 12.5 default to storing cached project data in a common location in your local Documents folder. It is recommended that you change the default location of your Project Media Cache on the system drive to another location on any Avid-qualified
storage. You can Change the location of the Project Media Cache in the User Media and Settings Project Media Cache preference in the
Pro Tools Operation Preferences. Any form of Pro Tools compatible storage, including shared storage, is a valid location to cache your
project data and media. However, at this time, multiple individual Pro Tools systems in a networked facility cannot refer to a shared
cached project bundle on shared storage. If there are multiple systems in a facility with shared storage, each Pro Tools system must
download its own project bundle to the specified local Project Media Cache bundle location.
Removing a collaborator from your project may not relinquish ownership of tracks claimed by that collaborator (PT-211627)

When a collaborator who has ownership over shared tracks is removed from a project that you own, their track ownership may not be
automatically relinquished. Should this issue occur, click the Track Ownership button for these tracks and ownership should be returned
to you after about five minutes.
Project uploads may pause while Shuttle Lock is active (PT-213277)

Entering Shuttle Lock mode while project uploads are in progress may temporarily prevent uploads from finishing until the playhead
comes to a stop. To avoid this issue, confirm that all uploads have completed in the Task Manager before using Shuttle Lock mode in
a project.
“Expand Alternates To New Playlists” may not trigger track or project uploads (PT-212809)

When a track has loop-recorded alternates that are not on any playlists, choosing to “Expand Alternates To New Playlists” may not trigger an auto-upload or allow manual uploading using the Track or Toolbar upload buttons. If this issue is encountered, making any
change or edit to the track or its playlists will enable uploading with the Track upload button.
Edit selection moved to the wrong playlist on a shared track. (PT-220200)

On a shared audio track received from a collaborator who reordered the track's playlist lanes (by click-dragging the lanes up and down),
the Move To... commands in the Right-click menu sends the selection to the wrong playlist. The collaborator reordering lanes and sharing can be on a Mac or Windows system, however, only Windows systems will have the issue on the receiving end. To avoid this issue,
make sure that collaborators do not manually reorder playlist lanes on shared tracks.
Tracks that are Shared As Frozen must be manually uploaded and saved. (PT-216854)

Any track that is Shared As Frozen must be manually uploaded (even if Global Auto Upload Changes is enabled) in order to render and
share changes with collaborators. If an edit is performed on a track that is Shared As Frozen, the project must be saved in order to preserve that edit, otherwise the edit will be lost.
Destructive Punch record passes are not transmitted to collaborators (PT-212577)

Using Destructive Punch to update a shared file does not transmit a track change and the file is not updated on collaborator systems.
Changed Display Name in Artist Chat is not updated in the Dashboard until signing out and signing back in (PT-209796)

After making a change to the Display Name in your Artist Chat profile, the Pro Tools Dashboard is not updated with the new user name
until you sign out and sign out and back in.
Artist Chat messages of 1,800 characters or more may not be received or even sent (PT-211701 and PT-214391)

Attempting to send an Artist Chat message of 1,800 or more characters can appear to send but may not be received by other users in the
chat or they may not be sent at all. The actual maximum limit for Artist Chat messages is 2 kilobytes per message. It is recommended
that uncommonly long messages be posted in shorter segments.
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Dropped Keystrokes in Artist Chat and Sign On Window (PT-211627)

In some cases keyboard keystrokes will fail to be transmitted to the Sign On and Artist Chat windows.
Pasting a text string inside of the “< >” characters into Artist Chat results in a blank entry (CLOUD-3285)

Any text in contained by “<" and ">” is disallowed for security reasons. Please do not use these characters in Artist Chat messages.
When sharing a track with plug-ins such as Melodyne or Space, only the waveform cache inside the plug-in is uploaded and
shared, but not the referenced audio file (PT-212607)

Media assets for Plug-ins (such as Melodyne or Space) that use external media, like a waveform cache or impulse responses, may not
always be copied with the shared tracks to the cloud for use by other collaborators.

I/O Setup
Master Faders assigned to mapped output busses function only on that specific bus, not for the output channel as a whole
(PTSW-127517)

Because a Master Fader works on a bus, not on an output path or output channel, there may be certain configurations in which the level
sent to the physical I/O is not reflected on any meters in the Pro Tools application. If the configuration includes output subpaths or has
multiple busses assigned to a single output path, the overall signal level from these combined sources (including any clipping indication)
will only be displayed on the interface itself. You can avoid using multiple output paths or output busses simultaneously by routing your
sources to a single mapped output bus and assign a Master Fader to that.
Session templates retain Bus settings and some preferences, display settings, and window layouts (PTSW-47133)

Pro Tools session templates retain the bus settings and some of the preferences, display settings, and window layouts from the system
on which the template was created. Consequently, creating a new session based on a template restores several session properties from
the original system. These properties are retained by Pro Tools until you change them, or another session or template is opened that replaces them. This also means that if a new blank session is created after using a template, the properties from the template will be used
for the new session.
The properties retained from templates include default track height, view settings, window size and position, and bus settings. You can
update templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install template in
system” option), and then selecting the template you want to replace.
Opening a session saved to .ptf (Pro Tools 7–9) from Pro Tools 12.x or higher in Pro Tools 8.1 or lower results in incorrectly
mapped IO (PTSW-194443)

For any session saved to .ptf (Pro Tools 7–9) from Pro Tools 12.x or higher requires that IO Settings be manually corrected when opening that session with Pro Tools versions 8.1 and lower. Manually map the correct IO settings in the IO Setup before playing back the
session.

File and Disk Management
Media tagged with names starting with symbols may not be returned during a Workspace search. (PT-223082)

If an audio file is tagged in Soundbase with a tag that begins with anything but a letter or number, that file may not be returned during
a search. To avoid this issue, use only tags that begin with a letter or number.
Database SQL Error when entering more than 66 tags in the Tags Search pane. (PT-221907)

If more than 66 tags are entered in the Tags Search bar in Soundbase, a database SQL error may occur. This error will prevent you from
a tag-based search until the number of tags is reduced.
On systems with multiple displays, the Assign Tags pop-up window may appear on a different display from the Workspace
browser (PT-223866)

When using more than one display, the Assign Tags pop-up window may appear on a different display from the Workspace browser.
This can happen when the primary display is arranged as the rightmost display and the Workspace browser is on another display. To
avoid this issue, move the Workspace browser to the primary display.
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After Relinking files the Relink window does not retain its “revealed/open” status (PTSW-178130)

Although the checkbox remains selected, the reveal status of volumes is not retained if the Relink window is automatically reopened.
Be sure to reveal the volumes so that the enabled checkboxes are visible in order to reliably relink to missing files.
When relinking audio files, mismatched channel widths are not found (PTSW-189868)

When relinking audio files, it is possible to link files with different channel widths. This is not a supported workflow and may have unpredictable results. Ensure that the channel width of linked files match the channel widths of clips in the session to avoid this issue.

Elastic Audio
Maintaining phase coherency with Elastic Audio pitch processing (PTSW-20602)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Monophonic or
Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio Pitch processing
from the track before switching to the Monophonic or Varispeed algorithm.
Drift in an audio file may occur when using Elastic Audio and the Monophonic or X-Form algorithms (PTSW-33768)

Drift in an audio clip may occur when using elastic audio depending on how much the clips is expanded or compressed when using the
Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient information in it that you would
like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.
Default Input Gain preference is only for Elastic Audio imported at session tempo (PTSW-34096)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported at Session Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or “Drag and Drop
from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.
Displayed Timebase is incorrect after importing Elastic Audio tracks (PTSW-46897)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will need to manually select the correct timebase for the affected tracks.
Elastic Audio clips on Playlist lanes are not rendered (PTSW-47311)

In Playlists View, any Elastic Audio clips on Playlist lanes are not rendered (waveform is “off-line”) when changing the track’s Elastic
Audio processing from Real-Time to Rendered. Using the object grabber to select any off-line clips, promoting them to the main playlist
or copying and pasting the clips in place will render using the selected Elastic Audio algorithm.
Clip Groups containing Elastic Audio are not recognized as Elastic if the Clip Group itself has not had any Elastic functions
applied (PTSW-34335)

If a clip group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level of the clip
group itself, then the clip group will not register as Elastic Audio. When used to create a new track, the track will not automatically be
Elastic Audio–enabled, and the elastic audio inside the clip group will be rendered using the default Elastic Audio plug-in for the session. As a workaround, add a warp marker to the clip group to force it to register as an elastic clip. Or, create an Elastic Audio–enabled
track first, then add the clip group to it.
Cannot import Elastic Audio tracks with the Consolidate From Source Media option (PTSW-33894)

Use Copy from Source Media to import Elastic Audio tracks.
Timing inaccuracy in audio files converted from CAF and MP3 with Preview In Context enabled (PTSW-46707)

Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio and innerclip asynchronous transients issues). This is inherent with compressed file formats.
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Track Commit and Track Freeze
Frozen Tracks are opened in a partially frozen state in certain versions of Pro Tools 12 (PT-208260)

Opening sessions created in Pro Tools 12.4 that have frozen tracks in Pro Tools 12.0 to 12.2.1 will result in graphical issues for “frozen”
clips (such as waveforms overlaying clip boundaries, missing clip boundaries, or clip boundaries that move without waveforms), tracks
and inserts (inserts can be in an inactive/frozen state and cannot be activated). In versions of Pro Tools 11.3.2 and earlier, or Pro Tools
12.3, these problems do not occur and the track is opened in it's unfrozen state.
Relinking to missing rendered “frozen” Auxiliary Input tracks does not yield any results when reopening a session (PT-210026)

If there is missing rendered audio from frozen Auxiliary Input tracks, they cannot be relinked after first time of reopening a session. Task
Manager will report: “Some Files to relink Not Found.” To correct this issue, close and reopen the session, and try to relink to the missing files again.
`Frozen tracks are not translated by AAF and Interplay unless committed (PT-210128)

Only the unprocessed source audio on frozen tracks is translated by AAF and Interplay To ensure that the desired track audio processing
is translated accurately for AAF sequences (and Avid Interplay), commit those tracks rather than freeze them.
Committing clips on Instrument tracks by dragging them to audio tracks with the Downmixer plug-in may render an incomplete
clip. (PT-207317)

Committing MIDI clips on Instrument tracks by dragging them to audio tracks with Downmixer may render an incomplete clip. Using
the Grabber tool on these incomplete clips may not function over the incomplete areas of the clip. To avoid this issue, Commit Instrument track clips to new Audio tracks before inserting the Downmixer plug-in.
When committing from two or more Instrument tracks in a session with tempo changes by dragging and dropping to audio
tracks, and where the Instrument tracks include a mix of sample-based and tick-based tracks, the tick-based committed clip is
trimmed to match the source MIDI original duration even though the audio committed from tick-based MIDI follows the tempo
changes. (PT-208300)

To avoid this issue, use the Trim tool to reveal the rest of the committed audio or commit sample-based MIDI clips and tick-based clips
separately.

MIDI
When recording MIDI, Wait for Note does not respond to MIDI input from ReWire (PTSW-30511 and PTSW-34550)

When performing a MIDI record, Wait for Note will not respond to any MIDI received from ReWire. If you are recording MIDI generated from a ReWire application, you will have to start the transport manually or use a countoff instead of Wait for Note.
When using Import Session Data on a MIDI track with Real-Time Properties enabled and set to using Diatonic transposition,
transposition is based on the first key signature in the session only (PTSW-49297)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the “Transpose
in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can be corrected by toggling the Real-Time Properties off and on; then the diatonic transposition will be correct for each key.

Plug-Ins
For known issues about specific plug-ins, see the Audio Plug-Ins Read Me.
When opening legacy sessions, the 4-band EQ III plug-in is converted to the 7-band EQ III plug-in

The AAX EQ III plug-in does not have a 4-band option. Pro Tools will automatically convert 4-band EQ III instances into 7-band instances if you are using only AAX plug-ins.
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When replacing one plug-in with another, the new plug-in inherits previously auto-enabled parameters. (PT-202826)

With the Plug-in Controls Default to Auto-Enabled preference enabled, all available automation parameters become unexpectedly re-enabled (merged) after replacing one instance of the plug-in with another. Disable this preference before replacing one plug-in with another to avoid this issue.
On Mac OS X 10.10.x, Avid Core Audio Plug-in causes audio disruption with Native Instrument plug-ins (PT-201944)

You cannot launch Native Instruments plug-ins if the Avid Core Audio plug-in is installed. To avoid this issue, remove the Avid Core
Audio plug-in from the Audio/Hal folder.
Custom location for Avid Virtual Instrument content is not remembered (PTSW-187501)

When installing AIR Creative Collection, if you choose a custom location for the content, that location is not remembered, resulting in
error messages when you try to use a virtual instrument plug-in (Boom, Mini Grand, or Xpand) that references a “.big” content file. The
location is not remembered after quitting and relaunching Pro Tools.
To avoid this error, move or reinstall the AIR Creative Collection content to the default location.
Some plug-ins require exclusive use of a DSP chip on HDX hardware-accelerated systems (PTSW-154614)

Certain plug-ins, such as ReVibe and Reverb One, use direct memory access (DMA) on HDX cards. DMA plug-ins cannot share HDX
DSP chips with other plug-ins. Additionally, even though DMA plug-ins of the same type can share a single HDX DSP chip (for example, multiple ReVibe plug-ins can use the same HDX DSP chip), they must be of the same channel width (DMA plug-ins of the same
type cannot share the same HDX DSP chip if they have different channel widths).
Pro Tools stops working when opening a session with Structure Free (PTSW-131965)

When opening a Pro Tools session that uses Structure Free, Pro Tools may hang temporarily if Structure Free is looking for files in a
directory where the files are not present.
AudioSuite and Clip Groups (PTSW-57457)

AudioSuite plug-ins handle Clip Groups in the Clip List slightly differently than audio files. With audio files, an AudioSuite process can
be applied to all copies of a unique audio file which appear in your session by selecting your target as Clip List in the AudioSuite plugin window and selecting Use in Playlist. However, if your target is set to Clip List in the AudioSuite plug-in window while you have a
Clip Group selected, Pro Tools does not recognize the Clip Group as processable audio and will present a No Audio was Selected error.
This is because a Clip Group is not treated as audio until it is actually used in a track.
To apply an AudioSuite process to all copies of a Clip Group in a session at once, do the following:
1

Select the Clip Group to be processed.

2

From the Clip List menu, select Ungroup All. All elements of the group will remain selected.

3

Perform AudioSuite processing.

4

From the Clip List menu, select Regroup.

5

When prompted, select Modify to apply the AudioSuite Process to all copies of the Clip Group in the session, or Copy to apply it only
to the selected Clip Group.

Rapidly showing and hiding the clip effects display during playback may cause temporary graphics artifacts. (PT-214987)

Rapidly showing and hiding the Clip Effects display during playback may cause areas of the Edit Window to appear partially missing
or in an otherwise incomplete state. Should this issue occur, stopping playback and then hiding or showing the Clip Effects display will
return all on-screen elements to their expected locations.
Clip effects may be rendered when rendering clip gain. (PT-218043)

When rendering clip gain for a clip, any active clip effects may also be rendered. To avoid unintentionally rendering clip effects, bypass
clip effects for the clip before rendering clip gain.
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HDX Systems
Pro Tools does not play back when an invalid Word Clock or AES/EBU sync source is selected on SYNC HD (PTSW-156651)

When attempting to initiate playback, playback will fail if a SYNC HD is connected to an HDX card and an Avid audio interface with
no connections to either the word clock or AES/EBU ports. Ensure that the clock is set to a working clock source to resolve this issue.
In Avid DigiTest, the reported slot number may not correspond to the physical slot number in the computer (PTSW-155373)

In Avid DigiTest, the slot number reported for HDX cards starts from 0 on up. For example, “Slot 1” does not necessarily correlate to
the first physical slot in the machine. If you have an HDX card that is having problems, match the Serial Number ID on the back of the
card with the Serial Number ID displayed on the Slot Info page in Avid DigiTest.
Pro Tools does not use HDX hardware if a Core Audio application is using HDX hardware (PTSW-155010)

When launching Pro Tools HD on an HDX hardware accelerated system, Pro Tools will use the Pro Tools Aggregate I/O as the Playback Engine if a Core Audio application has already engaged the HDX hardware. Be sure to quit all Core Audio applications before
launching Pro Tools HD to ensure that Pro Tools HD can use HDX hardware.
Assertions occur when opening a Pro Tools 12 session that uses the Native format of HEAT in Pro Tools 11.x and assigning
track outputs. (PT-204124)

A session saved from Pro Tools HD 12 on a Native system with HEAT enabled might not display DSP usage for HEAT when opened
on Pro Tools 11.x on an HDX system. To avoid these assertions and see DSP usage for HEAT on the HDX system, turn HEAT off and
then back on.

HD Native PCIe Systems
Audible pops and clicks occur when changing buffer sizes (PTSW-125715)

Pops and clicks may occur when changing the Hardware Buffer Size (H/W Buffer Size) in the Playback Engine dialog while monitoring
live audio through HD Native hardware. Avid recommends not changing the Hardware Buffer Size while monitoring live audio to avoid
this problem. If you must change the Hardware Buffer Size while monitoring live audio, be sure to lower the monitoring volume to avoid
any possible damage to your speakers.
There is no visual indication of bypassed plug-ins when Low Latency Monitoring is enabled with HD Native PCI. (PT-202108)

When using Low Latency Monitoring on a system with HD Native PCI, there may be no visual indication for bypassed plug-ins. Despite
this, enabling the Low Latency Monitoring option will in fact bypass all plug-ins in the session.

HD Native Thunderbolt Systems
HD Native Thunderbolt headphone output stops working when low latency monitoring is enabled (PTSW-169936)

The headphone output on the HD Native Thunderbolt does not function when low latency monitoring is enabled. In this case, use alternative monitoring source (such as an Avid HD OMNI).
HD Native Thunderbolt prevents the computer from waking after sleep (–9171 error) (PTSW-169172)

Pro Tools HD and HD Native Thunderbolt do not support the sleep function of Mac OS X. If encountered, disconnect HD Native Thunderbolt to wake the computer. Disable all sleep functions in System Preferences (except display) and shut down the computer. Reconnect HD Native Thunderbolt and start the computer.
HD Native Thunderbolt reports a clock error at higher sample rates (PTSW-168819)

With some computers, you may encounter an audio clock error when recording at higher sample rates (such as 96 kHz) and with lower
HW Buffer Size settings (such as 128 samples or less). In general, higher HW Buffer Size settings are recommended at higher sample
rates. For example, at 96 kHz, a HW Buffer Size setting of 256 samples or higher is recommended.
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HD Native Thunderbolt is only supported as the first or second thunderbolt device in a thunderbolt chain at sample rates up
to 96 kHz, and it must be the only Thunderbolt device in a chain at any sample rate above 96 kHz (PTSW-168229)

HD Native Thunderbolt is only supported as the first or second Thunderbolt device in a Thunderbolt chain at sample rates up to 96 kHz,
and must be the only thunderbolt device in a chain at any sample rate above 96 kHz. Visit the compatibility pages on the Avid website
for more information (www.avid.com/compato).
Pro Tools quits unexpectedly when selecting HD Native Thunderbolt in the Playback Engine (PTSW-167511)

After disconnecting and reconnecting HD Native Thunderbolt from your computer, Pro Tools quits unexpectedly when selecting
HD Native Thunderbolt in the Playback Engine. After disconnecting and reconnecting HD Native Thunderbolt, restart your computer
to avoid this problem.
Using the HD Native Thunderbolt headphone output with surround monitoring (HDM-13)

Headphone monitoring with HD Native Thunderbolt is set to mirror Pro Tools output channels 1 and 2 on the first audio interface. To
use HD Native Thunderbolt headphone monitoring with sessions that use surround formats (such as 5.1),change the surround monitoring path in I/O Setup so that the Left channel is mapped to Output channel 1 and the Right channel is mapped to Output channel 2.

Control Surfaces
Trim Scrub and Trim Shuttle don’t work on clips with fades (PTSW-46911)

If a clip has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around this problem,
remove any fades on the clip, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.
Used HW output path indication (101095)

In Assign Matrix mode on your control surface, Insert mode used for the hardware output path will not have amber background indicating that it's already assigned after switching to a different insert on the same track.
Color indication on plug-in controls in Learn mode (PTSW-18480)

When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs in the
plug-in window will be red if the track is in one of auto write modes. This conflicts with red color indication on the plug-in control,
which is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.
SignalTools meter ballistics on control surfaces (PTSW-52799)

SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Unaffected
types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times of the affected meters are not affected, only the decay times. All meter types display accurately in the plug-in window.
Channel Strip plug-in Expander/Gate meters appear in the Compressor/Limiter meter Instead of in the Expander/Gate meter in
D-Control Dynamics section (Main Unit) (PTSW-150897)

The Avid Channel Strip plug-in uses shared meters for Expander/Gate and Compressor/Limiter processing. Because of this, both Expander/Gate and Compressor/Limiter metering appear only in the Compressor/Limiter meter in D-Control Dynamics Section (Main
Unit).
Pro Tools transport must be stopped when recalibrating ICON faders (78074)

The transport in Pro Tools must be stopped when recalibrating faders on D-Command and D-Control. If one or more faders need calibration do the following: Stop playback, enter Utility mode, press TEST, press FADER, and press RECAL. After recalibrating faders.
exit Utility mode.
Adjusting Clip Gain with the Jog Wheel on a EUCON control surface can result in Pro Tools quitting unexpectedly
(PTSW-155028)

Adjusting Clip Gain using the Jog Wheel on a EUCON control surface during playback can result in Pro Tools quitting unexpectedly.
You can avoid this issue by using the mouse or key commands to adjust clip gain instead.
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Video
Video Engine may fail to initialize for non-administrator accounts (UME-1246)

For non-administrator OS X users, the Video Engine may not initialize if it has never been initialized under an admin account first. To
avoid this issue, launch Pro Tools as an admin and initialize the Video Engine in a session before doing so as a non-admin user.
Playback of QuickTime video in Pro Tools may stutter or drop frames

When monitoring QuickTime playback in the Pro Tools Video Window on the computer screen, the video image may stutter or drop
frames. To improve results with QuickTime playback, try any of the following:
• Disable Continuous Scrolling.
• Close unnecessary UI windows.
• Try using the DNxHD codec.
• A second Pro Tools or Media Composer Video Satellite option offers guaranteed performance for Avid video playback with a primary
HDX or HD Native system.
QuickTime files that contain multiple CODECs may not import (UME-835)

If the Pro Tools tells you that a file cannot be imported because it may be unsupported, check to see if the file contains more than one
CODEC. This can be done by opening the file in QuickTime player and examining the file properties. QuickTime files that contain more
than one CODEC are not officially supported for import into Pro Tools.
Playback of PhotoJPEG-encoded video experiences dropped frames or stuttering (PTSW-183056)

PhotoJPEG is not a preferred CODEC for video playback in Pro Tools. It you experience performance issues with this CODEC, please
transcode to a preferred Avid CODEC, such as DNxHD or DV25. This can be done by bouncing the file to QuickTime from within
Pro Tools and choosing the “Advanced Settings” in the bounce window.
Video pull factor may become invalid when video hardware is enabled (PTSW-180554)

If a software video pull factor of 0.1% is set while video hardware is disabled, enabling the video hardware may create an illegal pull
setting. Video hardware only supports 0.1% pull ups at 24pPAL rates, and 0.1% pull downs at 25pPAL rates. If the pull rate is set to
0.1% at any other rate while video hardware is enabled, manually select an available option from the pull menu, which may be “none.”
Video may not stay in sync when video hardware is attached and Pro Tools is locked to an external clock (PTSW-178722)

If both Pro Tools and an attached video peripheral are each resolved to an external clock, but the clock is not derived from the same
source, video will not stay in sync. An example of this would be if the video peripheral is locked to black burst, and the audio peripheral
is locked to an audio clock not derived from the same video black burst, such as SPDIF. In this scenario, setting the video peripheral to
lock to its own internal clock will allow Pro Tools to compensate for video drift over time.
Unsupported QuickTime video formats (PTSW-52140, PTSW-52155, PTSW-52156, PTSW-53625, 72961)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format movies.
Attempting to import these will generate errors or will fail to import.
QuickTime files that contain multiple CODECs may not import (UME-835)

If the Pro Tools tells you that a file cannot be imported because it may be unsupported, check to see if the file contains more than one
CODEC. This can be done by opening the file in QuickTime player and examining the file properties. QuickTime files that contain more
than one CODEC are not officially supported for import into Pro Tools.
“Error reading video in the QuickTime files” when importing some MPEG 1 and 2 video files in Pro Tools (PTSW-178017)

Some MPEG1 and MPEG2 files cannot be opened by Avid applications, including Pro Tools. Transcode these files to one of our primary CODEC such as DNxHD or AppleProRes for use in Pro Tools to avoid this issue.
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3G2 file extension is not supported for video import (PTSW-178015)

Pro Tools 11 and higher provides support for the .3GP file type extension for video import. These are video files often created on mobile
phones. The second generation of this format uses the file extension of .3G2. Files with the .3G2 file extension will be filtered out as
unavailable for video import. These .3G2 files may be available for import if their file extension manually changed to .3GP. If the files
remain unavailable for import after changing their extension, they will need to be converted to an explicitly supported format such as
DNxHD or AppleProRes for use in Pro Tools.
Video I/O Settings Pane appears inactive after editing video track during play (PTSW-183106)

If you edit video during playback, the I/O Setting pane for the Video track appears inactive during playback, preventing you from opening the track’s Output Setting tab. To access I/O settings for the track, stop playback.

Third-Party Video Peripherals
The following issues may occur with third-party video hardware. Please contact your hardware vendor for support.
In some cases, video will not stay in sync over time if the video peripheral is not, or cannot, lock to video reference. If you experience
this, a workaround is to set the Pro Tools clock to internal. This will cause the video peripheral to slew overtime and stay in sync with
Pro Tools. (THPV-2)



 When Pro Tools is running with a Blackmagic DeckLink II Extreme or Intensity video capture and playback PCI-e card installed,
launching Blackmagic Design’s Deck Capture utility, Final Cut Studio, or any other application which supports Black Magic hardware
for video output, can result in system instability. To avoid any potential system instability only use one Blackmagic DeckLink–aware
application at a time. (PTSW-19486)


With some peripherals video playback will be one frame out of sync with Pro Tools audio. To compensate for this, choose Setup >

Video Sync Offset and enter a 1 frame offset. (THPV-9)

With some video peripherals, the video output will be scrambled when video is not loaded in Pro Tools, or when the video peripheral
is disabled. (THPV-32)



Video Satellite
23.976 or 24 fps Sequence Start Time Ending In Digits Other than “:00” Causes Time Code Offset

Media Composer uses NTSC or PAL time code when setting the sequence start time regardless of the format selected by the user for
display. When you are working on a video satellite project at 23.976 or 24 fps, a Media Composer sequence with a start time that ends
in a value other than :00 causes an offset between Pro Tools and Media Composer at the session start. For example, the start time
45:02:10:15 (ending in :15) would cause an offset, but the start time 45:02:10:00 (ending in :00) would not.
As a workaround, always set your Media Composer sequence start time to a time code value ending in 00.
Cueing from Media Composer in a 720p Project Causes 1-Frame Offset (Item # 98460)

In 720p projects, Media Composer counts at 50 or 60 (59.94) progressive fps—depending on the project type—while Pro Tools counts
at 25 or 29.97 frames per second. When you cue a sequence from the video satellite in a 720p project, the Pro Tools edit cursor can be
offset by as much as one frame.
As a workaround, cue and play back from Pro Tools when working with a 720p project in a video satellite system. This ensures that the
two applications are always in sync. It is not possible to cue to odd 50 or 60 frame boundaries (for example, frame 47) from Pro Tools.
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Audio and video may drift out of sync In Satellite Mode in certain conditions (Items # UDevC00090064, UDevC00090078,
UDevC00088666, UDevC00089437, UDevC00087542)

When operating in Satellite mode, audio and video output from Media Composer may drift out of sync by as much as one frame in any
of the following conditions:
• When viewing video full screen in 1394 mode. This is due to the difference between the monitor's refresh rate and the video reference
rate.
• When the Edit Play Rate of the video differs from the frame rate of the video reference signal. (For example, this occurs with a 24p
NTSC project with 23.976 Edit Play Rate and NTSC reference signal.)
• When looping a selection that is not aligned to video frame boundaries in Pro Tools. As a workaround, make your selection in
Pro Tools using Grid mode with the Grid value set to 1-frame increments—especially when it is necessary to loop several times without stopping.
When scrubbing with a Video Satellite, video may be offset by several frames (UME-870)

Audio/video sync is not frame accurate when scrubbing a Video Satellite. An offset of several frames may be seen between the
Media Composer system and the Pro Tools system. To monitor frame accurate video when scrubbing, use the Pro Tools Video window.
When done scrubbing, you can continue to monitor frame accurate video on the Video Satellite.

General Localization
AAF/OMF sequences with non-English characters import with garbled clip names or won't relink (PTSW-33569, PTSW-99570,
PTSW-33826)

If an AAF/OMF sequence containing files or clip names with non-English characters is exported from a Mac-based Pro Tools 7.3.1 system (or lower), it may not import correctly into Avid Media Composer, or Pro Tools 7.4 and higher systems on Windows or Mac. Conversely, AAF/OMF sequences with non-English characters exported from any Pro Tools 7.4 or higher system (or higher) may not import correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the files, select “Manually Find and Relink,” then deselect
all options except “Find by file ID.” Clip names may appear garbled.

Known Issues with CoreAudio Hardware Drivers
Limitations of the Avid CoreAudio Driver

When using Pro Tools HD software with HDX or HD Native hardware, Pro Tools HD software requires exclusive access to the hardware. Consequently, you cannot use CoreAudio applications and Pro Tools HD software at the same time on these systems. The Avid
CoreAudio Driver and the operating system handle transitioning between applications automatically, so there is no need to quit all
CoreAudio applications before launching Pro Tools HD as with previous versions of this driver.
The Avid CoreAudio Driver cannot be used to preview sound files from the Mac Finder while Pro Tools is running. When a sound file
is located in the Mac OS X navigation window, a QuickTime transport bar is displayed next to it. The QuickTime transport bar lets you
audition the sound file. With USB audio interfaces, you can preview sound files from the Mac Finder as long as Pro Tools is not running.
Regardless, with FireWire and Avid HD audio interfaces, the sound will always play back though the Mac built-in audio controller
(through the Mac speaker or headphone jack). However, if you double-click a sound file, the QuickTime application launches and it can
use the Avid CoreAudio Driver for playback.
The Avid CoreAudio Driver cannot be used for playback of Mac System Sounds.
Pops when changing sample rates (PTSW-58770)

With the CoreAudio Manager, your Pro Tools hardware may produce a “pop” or “click” sound if Pro Tools was last used at a sample
rate different from the one the new CoreAudio client is set to use.
Audio streaming problems when using very low H/W Buffer Sizes with 3rd party Core Audio applications (such as Logic)
(PTSW-154719)

You may experience audio streaming problems when using Avid hardware with 3rd party applications such as Cubase or Logic and
playing back at the lowest buffer size. The lowest supported buffer sizes when using Avid hardware are 64 at 44.1 and 48 kHz sessions,
and 128 at 88.1 and 96 kHz.
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Buffer sizes incompatible with Pro Tools hardware (39542)

In Cubase, Traktor, Live, and certain other applications, you can select Buffer Sizes that may be incompatible with your Pro Tools hardware. Selecting incompatible buffer sizes results in distorted sound and may cause other problems. Please make sure to select Buffer
Sizes listed in the following chart:
Cubase SX Buffer Sizes Supported by Avid Audio Hardware
Avid Audio Hardware

Supported Buffer Sizes

HDX

128, 256, 512, 1024

HD Native

128, 256, 512, 1024

003, 003 Rack, 003 Rack+, Eleven Rack

64, 128, 256, 512, 1024

Mbox® and Mbox 2-series interfaces

32, 64, 128, 256, 512, 1024

Pro Tools reports a –6101 error connecting or disconnecting headphones or audio cables from the audio output jack on your
computer while using Pro Tools (PTSW-159325)

You may encounter a –6101 error when connecting or disconnecting headphones or audio cables from the audio output jack on your
computer while using Pro Tools. To avoid this problem, quit Pro Tools before connecting or disconnecting your headphones or audio
cables.

Known Issues with Audio Interfaces
HD OMNI
Noise in the output signal from HD OMNI with digital input (PTSW-1614)

If HD OMNI is connected to a digital source with a mismatched clock and Sample Rate Conversion (SRC) is not enabled, you will hear
noise (including loud “pops”) in the output signal. To correct this problem, either enable SRC or ensure that the clock of the digital
source and HD OMNI are matched correctly.
HD OMNI front panel Setup menus are unresponsive after Pro Tools quits unexpectedly (PTSW-125692)

HD OMNI will not automatically recover “stand-alone” mode if Pro Tools quits unexpectedly (or if you disconnect the DigiLink cable
from HD OMNI while Pro Tools is running). As a result, some of the SETUP functions accessible from the front panel will be unavailable. Power cycle HD OMNI to recover stand-alone mode.
Graphic redraw problems in the Hardware Setup dialog (PTSW-122690, PTSW-1346, and PTSW-1235)

When changing the Hardware Setup configuration for HD OMNI, it is possible to encounter graphics redraw problems in some cases.
To force a graphics redraw of the Hardware Setup dialog, close and reopen the Hardware Setup dialog.
No sound on output after hardware reset (PTSW-126575)

After resetting the HD OMNI interface to the default factory settings using the front panel controls, the HD OMNI interface stops emitting sound in sessions where the outputs are not assigned to the Monitor output path. To correct this problem, press the ALT monitor
button to switch to the ALT Monitor path, and then press it again to switch back to the Main Monitor path.
Loss of Monitor path when launching Pro Tools with HD OMNI off or disconnected (PTSW-127313)

When launching Pro Tools and opening I/O Setup after powering off HD OMNI or disconnecting it from the system, the inactive Monitor path is not present in Output tab. You may need to restore the default I/O Settings and remap the corresponding Output Busses.
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Output paths are not automatically created in the Output page of the I/O Setup after disabling the corresponding Monitor path
in the Monitor page of the Hardware Setup and re-assigning the Outputs from “None” to physical outputs in the Main page of
the Hardware Setup (PTSW-127559)

After disabling the Monitor path in the Monitor page of the Hardware Setup and re-assigning the corresponding Outputs from “None”
to physical outputs (such as “A 1-2”) in the Main Page of the Hardware Setup, these Output paths are not automatically created in the
Output Page of the I/O Setup. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).
Changing Monitor path Output assignments in the Hardware Setup does not update the Output paths in the Output page of the
I/O Setup (PTSW-127563)

When changing Monitor path Output assignments in the Monitor page of the Hardware Setup (such as setting the Monitor path Format
to None or assigning the Monitor to different physical outputs), the Output paths in the Output page of the I/O Setup do not reflect the
corresponding changes. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).
When creating new sessions, using the I/O Settings selector can result in unexpected Output assignments if HD OMNI has an
assigned Monitor path (PTSW-123896)

If HD OMNI has an assigned Monitor path, Output paths created by the selected I/O Settings option in the New Session dialog may be
offset by the channel width of the Monitor path. If this happens, you will have to manually create the appropriate Output paths in the
I/O Setup (or click Default).
I/O Setup Bus page erroneously adds monitor paths (PTSW-127739)

With both MAIN and ALT Monitor paths declared, toggling one of the CR Monitor paths from the current format to “None” and then
back to the starting Monitor format from within the Hardware Setup Monitor page, causes the Bus page in I/O Setup to erroneously add
an extra Monitor path with the abbreviation with “(1).” This can happen numerous time and each new Monitor abbreviation increments
accordingly.

003 Series Interfaces
Reconnecting an 003 after losing the connection with Pro Tools (PTSW-20351)

If your 003 series interface loses its connection with Pro Tools, increasing your buffer size may bring the device back online without
having to close Pro Tools or restart your computer.
Importing .PIM Files on an 003 System with a C|24 (PTSW-46401)

When importing a custom map .PIM file created on a 003 to another 003 system with a C|24, 003 displays “<No Track>” on the scribble
strips instead of staying in Plug-in Edit mode with a restored newly imported Plug-in Map. You will need to switch to another mode on
003 and then re-enter Plug-in Edit mode to correct this.

Mbox Pro
Pro Tools appears unresponsive with Mbox Pro (PTSW-184498)

Avid recommends connecting the Mbox Pro before powering up the computer. If Pro Tools appears to be unresponsive with Mbox Pro,
check to ensure that the Mbox Pro is synchronized to the proper clock source (Setup > Hardware), and that the clock source and your
Pro Tools session have matching sample rates. If Mbox Pro encounters a problem with the clock source (such as mismatched sample
rates between the clock source and the session), Pro Tools may become unresponsive.

Pro Tools Aggregate I/O (Mac Built-In Audio)
–6101 error when previewing audio with Pro Tools Aggregate I/O (PTSW-132996)

When previewing audio in the Import Audio dialog with Pro Tools Aggregate I/O selected as the Current Engine (in the Playback Engine dialog), and with the Mac OS File view is set to Columns view, you may encounter a –6101 error. Try changing the Mac OS file
view from Columns to List or Icons view, or use any of the built-in audio devices instead of Pro Tools Aggregate I/O to avoid this problem.
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Changing sample rates in Audio MIDI Setup can cause Aggregate I/O to disappear in I/O Setup, resulting no audio output
(PTSW-132281)

When Pro Tools Aggregate I/O is selected as the Current Engine in the Playback Engine dialog, changing sample rates in Audio MIDI
Setup can cause the Pro Tools Aggregate I/O to be removed from I/O Setup resulting in no audio output. To correct this problem, click
the Default button on the Output page of the I/O Setup.
Error messages when opening a session with a different sample rate from the Aggregate I/O sample rate setting (PTSW-131779)

Pro Tools may indicate that a given Aggregate I/O device has not automatically adjusted its sample rate when a session with a different
sample rate is opened. You may subsequently be presented with a dialog indicating that the session needs to be closed and reopened to
update the sample rate setting of the Aggregate I/O device.
Renaming Pro Tools Aggregate I/O driver in AMS corrupts the driver (PTSW-131383)

If you rename the Pro Tools Aggregate I/O driver in Audio MIDI Setup (AMS), the driver be corrupted the next time you launch
Pro Tools. If this happens, quit Pro Tools and delete the Pro Tools Aggregate I/O device from AMS. Pro Tools will re-create the driver
the next time it is launched.
Pro Tools quits unexpectedly when enabling the built-in digital I/O (PTSW-132189)

When enabling built-in digital I/O for Pro Tools Aggregate I/O in Audio MIDI Setup, Pro Tools quits unexpectedly. To avoid this problem, enable the built-in digital I/O in Audio MIDI Setup before launching Pro Tools.

Third-Party Core Audio Devices
Using low buffer sizes with Studio Monitor Express may result in Pro Tools quitting unexpectedly with a loud burst of noise
(PTSW-132513)

Using Studio Monitor Express with some Core Audio Devices may result in Pro Tools quitting unexpectedly along with loud bursts of
noise. Studio Monitor Express is not recommend for use with Pro Tools at this time.

Error Messages
Error –1150 (PTSW-144422)

When launching Pro Tools HD on HDX hardware, if you encounter a –1150 error, quit Pro Tools, shut down your computer, and ensure
that the HDX TDM cable is properly connected.
Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you will
need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 error, quit and
relaunch Pro Tools, open the Playback Engine dialog, and change the Number of Voices setting to use fewer voices per DSP.
Error –9073 without reaching the 2 GB file limit

If you encounter a –9073 error, and you have not reached the 2 GB file size limit, please refer to the Knowledge Base for possible causes
and solutions (www.avid.com/onlinesupport).
Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid –9128 errors during playback with Native plug-ins or dense automation.
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Error –9131 (92747a, 20843)

GUID partitioned drives will not allow you to record beyond the third partition when running on OS X. A workaround is to partition audio drives using Apple Partition Map instead of GUID.
– or –
Recording to or playing from a UNIX File System (UFS) formatted drive is not supported in Pro Tools.
Error –9132 (32397)

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the appropriate tracks to
the appropriate number and format of audio tracks, and record to disk. You can then use the resulting audio files as you would have used
bounced files.
Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid –9155
errors during playback with dense automation.
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